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Information Engineering

Design, Create and Manage Conceptual, Logical and
Physical Data Models

The power of model-based system development is the
ability to visualize, analyze and design all aspects of a
system. Being able to view and manage information and
data alongside other models of a system provides great
clarity and reduces the chance of error. Enterprise Architect
has extensive support for the data modeling discipline,
ranging from the representation of information in a
conceptual model right down to the generation of database
objects. Whether you are generating database objects from
the UML model or reverse engineering legacy DBMS into a
model for analysis, the tool features will save time and
valuable project resources.
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This illustration shows the Database Builder Interface
including DDL Generation and the Foreign Key dialog.

Enterprise Architect supports the modeling of information at
the conceptual, logical and physical layers. Using a number
of standard features, these models can be interconnected,
providing traceability. The logical and physical models can
also be generated automatically using a fully customizable
Transformation engine. Legacy systems can be imported,
analyzed and compared using the handy reverse engineering
facility.

In this topic you will learn how to use the feature rich
toolset including the Database Builder to design, create,
manage, visualize data including reverse and forward
engineering of data models to live database.

The Database Builder tool can be used to create and
maintain physical data models and can connect to a running
DBMS, so you can therefore import, generate, compare and
alter a live database.

(c) Sparx Systems 2026 Page 7 of 339
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Getting Started

Information Modelers, Data Modelers and Architects are
responsible for creating models of an organization’s
information that span multiple levels of abstraction, from
conceptual through to logical and physical. The conceptual
models are technology independent and can be used for
discussions with business people and domain experts,
allowing the basic concepts in the domain to be represented,
discussed and agreed upon. The logical model elaborates the
conceptual model, adding more detail and precision but is
still typically technology neutral, allowing Information
Analysts to discuss and agree on logical structures. The
physical model applies technology specific data to the
models and allows engineers to discuss and agree on
technology decisions in preparation for generation to a
target environment, such as a database management system.

Selecting the Perspective

Enterprise Architect partitions the tool's extensive features
into Perspectives, which ensures that you can focus on a
specific task and work with the tools you need without the
distraction of other features. To work with the Data
Modeling features you first need to select one of these
Perspectives:

El<perspective name> > Database Engineering > Database
Engineering
EI<perspective name> > Database Engineering > Entity

(c) Sparx Systems 2026 Page 8 of 339
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Relationships

Setting the Perspective ensures that the Database
Engineering diagrams, their tool boxes and other features of
the Perspective will be available by default.

Example Diagram

An example diagram provides a visual introduction to the
topic and allows you to see some of the important elements
and connectors that are created in specifying or describing
the way a data model 1s defined including: Tables, Views,
Procedures, Sequences, Functions.

Data Model Types

Information can be modeled at a number of level of
abstraction starting with a conceptual model that is typically
created by or for business people, a Logical model which 1s
used by business and systems analysts and a physical model
which is the concern of the technologists such as database
engineers. In this topic you will learn how to manage all
three levels of information models.

Creating and Managing Data Models

In this topic you will learn how to work 1n detail using
Enterprise Architect to manage your Physical Database
schema. This includes the use of the Database Builder tool

(c) Sparx Systems 2026 Page 9 of 339
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which allows you to interact with any number of live
database through an ODBC connection.

Import Database Schema

This topic will show you how to connect to a live database
including Production, Test and Development systems and
reverse engineer the database into a model creating Tables,
Views, Procedures, Declarative Referential Integrity and
more. A diagram of the database is automatically created
and the elements such as tables can be related to other
elements 1n the model including Conceptual and Logical
Models, Programming classes tests and more.

Generate Database Definition Language
(DDL)

In this topic you will learn how to harness the power of the
data models by generating Database Definition Language
code directly from the model. Enterprise Architect can
generate code into a wide range of Database Management
systems.

Supported Database Management Systems

Enterprise Architect has rich support for most of the main
stream Database Management Systems (DBMS). This
feature allows models from disparate systems to be

(c) Sparx Systems 2026 Page 10 of 339
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compared either for code generation or for analysis by using
the import feature. This topic lists the supported DBMS and
More Information

This section provides useful links to other topics and
resources that you might find useful when working with the
Data Modeling tool features.

(c) Sparx Systems 2026 Page 11 of 339
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Example Diagram

Using the Database engineering features of Enterprise
Architect you can create rich models of the objects that
make up a data model at any level of abstraction from
Conceptual through Logical to Physical. These models are
created by adding tables and other database objects from the
toolbox or by reverse engineering and existing database into
a model from a range of RDBMSs. A database diagram can
contain Tables, Vlews, Procedures, Sequences and
Functions. Table Columns are annotated as Primary and
Foreign Keys are modeled using specialized association
relationships. In this example the user has created a simple
physical data model of Customers and their Addresses and
Orders.

(c) Sparx Systems 2026 Page 12 of 339
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+pk_customers

customers

«column»

*PK id: bigserial

first_name: varchar(50)
middle_name: varchar(50)
surname: varchar(50)
date_of_birth: date
phone_no: varchar(20)
mobile_no: varchar({20)
email: varchar({100)

«FK»

{customer_id =id)

+fk_customersaddresses_customers

customers_addresses

«wcolumn»

*PK id: serial

FK customer_id: bigserial
billing_or_delivery: bit{1) =1
active: bit{1)
line_1: varchar({50)
line_2: varchar({50)
line_3: varchar({50)
city: varchar(100)
state_province: varchar(20) = 'Victoria'
zip_postcode: varchar(10)
country: varchar(100) = ‘Australia’
comments: text

«FK»
+  fk_customersaddresses_customers(bigserial)

windex»
+  ixfk_customersaddresses_customers(bigserial)

«PK»
+  pk_customersaddresses(serial)

comments: text

+pk_customers

+

+

+
+

«PK»
pk_customers{bigserial)
«unigue»
ug_customers_email(varchar)
«index»
ix_customers_surname(varchar)
ix_customers_mobile({varchar)

«FK»
|

(customer_id =id)

+fk_customersorders_customers

customers_orders

«column»

*PK id: bigserial

FK customer_id: bigserial
order_date: date
paid_date: date
shipped_date: date
total_price: double precision
special_instructions: varchar(255)

consignment_no: varchar({50)

comments: text

«FK»

+  fk_customersorders_customers(bigserial)
«PK»

+  pk_customersorders|bigserial)
«unigque»

+  uqg_customersorders_consignment(varchar)

Physical Data model showing Tables with Columns and
Primary and Foreign Keys.

(c) Sparx Systems 2026
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Working with Data Model Types

Enterprise Architect provides a number of features to assist
in the process of creating models of information, including
the ability to develop conceptual, logical and physical
models and to be able to trace the underlying concepts
between the models. The physical models can be developed
for a wide range of database systems, and forward and
reverse engineering allows these models to be synchronized
with live databases.

Data Models

Type Description

Conceptual Conceptual data models, also called

Data Models = Domain models, establish the basic
concepts and semantics of a given
domain and help to communicate these to
a wide audience of stakeholders.
Conceptual models also serve as a
common vocabulary during the analysis
stages of a project; they can be created in
Enterprise Architect using
Entity-Relationship or UML Class
models.

Logical Data = Logical data models add further detail to

(c) Sparx Systems 2026 Page 14 of 339
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Models conceptual model elements and refine the
structure of the domain; they can be
defined using Entity-Relationship or
UML Class models.

One benefit of a Logical data model is
that i1t provides a foundation on which to
base the Physical model and subsequent
database implementation.

Entity-relationship modeling is an
abstract and conceptual database
modeling method, used to produce a
schema or semantic data model of, for
example, a relational database and its
requirements, visualized in
Entity-Relationship Diagrams (ERDs).

ERDs assist you in building conceptual
data models through to generating Data
Definition Language (DDL) for the target
DBMS.

A Logical model can be transformed to a
Physical data model using a DDL
Transformation.

Physical Data Physical data models in Enterprise

Models Architect help you visualize your
database structure and automatically
derive the corresponding database

schema; you use Enterprise Architect's
UML Profile for Data Modeling

c) Sparx Systems age 150
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specifically for this purpose.

The profile provides useful extensions of
the UML standard that map database
concepts of Tables and relationships onto
the UML concepts of Classes and
Associations; you can also model
database columns, keys, constraints,
indexes, triggers, referential integrity and
other relational database features.

Because Enterprise Architect helps you
visualize each type of data model in the
same repository, you can easily manage
dependencies between each level of
abstraction to maximize traceability and
verify completeness of system
implementation.

(c) Sparx Systems 2026 Page 16 of 339
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Conceptual Data Model

A Conceptual data model is the most abstract form of data
model. It 1s helpful for communicating ideas to a wide range
of stakeholders because of its simplicity. Therefore
platform-specific information, such as data types, indexes
and keys, 1s omitted from a Conceptual data model. Other
implementation details, such as procedures and interface
definitions, are also excluded.

This is an example of a Conceptual data model, rendered
using two of the notations supported by Enterprise
Architect.

."---. -
Customers — .,_.-«': | Customer Addresses

1

Entity Relationship diagram showing a One-to-Many
relationship

Using Entity-Relationship (ER) notation, we represent the
data concepts 'Customers' and 'Customers Addresses' as
Entities with a one-to-many relationship between them. We
can represent exactly the same semantic information using
UML Classes and Associations.

Customers Addresses

Customer ‘

] 1

Unified Modeling Language diagram showing the same
One-to-many Relationship

(c) Sparx Systems 2026 Page 17 of 339
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Whether you use UML or ER notation to represent data
concepts 1n your project depends on the experience and
preferences of the stakeholders involved. The detailed
structure of the data concepts illustrated in a Conceptual
data model 1s defined by the Logical data model.

(c) Sparx Systems 2026 Page 18 of 339
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Entity Relationship Diagrams (ERDs)

According to the online Wikipedia:

An entity-relationship model (ERM) is an abstract and
conceptual representation of data. Entity-relationship
modeling is a database modeling method, used to produce a
type of conceptual schema or semantic data model of a
system, often a relational database, and its requirements in
a top-down fashion. Diagrams created by this process are
called Entity-Relationship Diagrams, ER Diagrams, or
ERD:s.

Entity Relationship Diagrams in Enterprise
Architect

Entity Relationship diagrams in Enterprise Architect are
based on Chen's ERD building blocks: entities (tables) are
represented as rectangles, attributes (columns) are
represented as ellipses (joined to their entity) and
relationships between the entities are represented as
diamond-shape connectors.

ERD technology in Enterprise Archltect assists you in every
stage from building conceptual data models to generating

(c) Sparx Systems 2026 Page 19 of 339
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Data Definition Language (DDL) for the target DBMS.

ERD and ERD Transformations

Enterprise Architect enables you to develop Entity
Relationship diagrams quickly and simply, through use of
an MDG Technology integrated with the Enterprise
Architect installer.

The Entity Relationship diagram facilities are provided in
the form of:

. An Entity Relationship diagram type, accessed through
the 'New Diagram' dialog

. An Entity Relationship Diagram page in the Diagram
Toolbox

. Entity Relationship element and relationship entries in the
"Toolbox Shortcut' menu and Quick Linker

Enterprise Architect also provides transformation templates
to transform Entity Relationship diagrams into Data
Modeling diagrams, and vice versa.

Entity Relationship Diagram Toolbox Page

You can access the 'Entity Relationship Diagram' page of
the Diagram Toolbox by specifying 'Entity Relationship
Diagrams' in the Toolbox 'Find Toolbox Item' dialog

(c) Sparx Systems 2026 Page 20 of 339
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ERD

@ Entity
O Attribute
<@ N-ary Association

ERD - Relationships
/  Connector

Q Relationship
97 Disjoint
IR Overlapping

. Entity 1s an object or concept that is uniquely identifiable;
the property of 'Multiplicity' in the SourceRole and
TargetRole definitions for the Relationship connector can
be used to define the cardinality of an Entity that

participates in this relationship
. Attribute is a property of an entity or a relationship type

. N-ary Association represents unary (many-to-many
recursive) or ternary relationships and can also be used to
represent relationships that have attributes among the
entities; the N-ary Association element should always be
at the target end of a connector

. Connector is a connector between an Entity and an
Attribute, and between two Attributes

. Relationship is a diamond-shape connector, representing
the meaningful association among entities

. Disjoint and Overlapping represent the relationships
between the super-class Entity and the sub-class Entity

A typical Entity Relationship diagram

(c) Sparx Systems 2026 Page 21 of 339
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Next_of Kin

0

Tagged Values

Some of the Entity Relationship diagram components can be
modified by Tagged Values, as indicated:

Component Tagged Value / Notes

Entity 1IsWeakEntity
Notes: If true, this entity 1s a weak entity.

(c) Sparx Systems 2026 Page 22 of 339
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Attribute attributeType
Notes: There are four valid options:
'normal’, 'primary key', 'multi-valued' and
'derived'

Attribute commonDataType

Notes: Defines the common data type for
each attribute.

Attribute dbmsDataType

Notes: Defines the customized DBMS
data type for each attribute. This option is
only available when the
commonDataType tag is set to 'na'.

Y ou must define the customized type first
through the 'Settings > Reference Data >
Settings > Database Datatypes' ribbon
option.

N-ary isRecursive

Association  Notes: If true, the N-ary Association
represents the many-to-many recursive
relationship.

For one-to-many and one-to-one
recursive relationships, we suggest using
the normal Relationship connector.

Sometimes you might want to limit the

(c) Sparx Systems 2026 Page 23 of 339
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stretch of the diamond-shape
Relationship connectors; simply pick a
Relationship connector, right-click to
display the context menu, and select the
'Bend Line at Cursor' option.

Relationship  isWeak

Notes: If true, the Relationship 1s a weak
relationship.

Disjoin Participation
Overlapping | Notes: There are two valid options,
'partial’ and 'total'.

Notes

. Entity Relationship diagrams are supported in the
Corporate, Unified and Ultimate Editions of Enterprise
Architect

(c) Sparx Systems 2026 Page 24 of 339



Information Engineering 4 May, 2026

Logical Data Model

Logical data models help to define the detailed structure of
the data elements in a system and the relationships between
data elements. They refine the data elements introduced by a
Conceptual data model and form the basis of the Physical
data model. In Enterprise Architect, a Logical data model 1s
typically represented using the UML Class notation.

Example

This diagram 1s a simple example of a Logical data model.
The Logical Model adds detail to the Conceptual Model but
without going to the level of specifying the Database
Management System that will be used.

Customers Addresses

Customers
- billing or delivery: boolean
- first name: sting - adive: boolean

- middle name: string - address linel: string

- surname: string - address line2: string

- date of birth: date 1 .| - =address lined: string

- phone number: string - city: sting

- mebile number: string - zip/postoode: string

- email: string - state: string

- comments: string -  country: string

- comments: string

Conceptual Data Model with tables modeling Customers
and their Addresses.

Note that the data elements 'Customers' and 'Customers
Addresses' contain UML attributes; the names and generic
data types to remain platform-independent.
Platform-specific data types and other metadata that relate to

c) Sparx Systems age 250
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a specific DBMS implementation are defined by the
Physical data model.

(c) Sparx Systems 2026 Page 26 of 339
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Physical Data Models

A Physical Data Model visually represents the structure of
data as implemented by a relational database schema. In
addition to providing a visual abstraction of the database
structure, an important benefit of defining a Physical Data
Model 1s that you can automatically derive the database
schema from the model. This is possible due to the richness
of metadata captured by a Physical Data Model and its close
mapping to aspects of the database schema, such as database
Tables, columns, Primary Keys and Foreign Keys.

Example Data Model

This example shows a Physical Data Model that could be
used to automatically generate a database schema. Each
Table 1s represented by a UML Class; Table columns,
Primary Keys and Foreign Keys are modeled using UML
attributes and operations. This model demonstrates the use
of the Information Engineering connector style.

customers_addresses E

“PK id: serial
*PK id: bigserial FK customer_id: bigserial

ssssss e: varchar50)
date_of_birth: date

{customer_id = id)
Fkx
11 =
1T Oé

+pk_customers +fi_customersaddressescustomers

wFHx

+ uq_customers_email{varchar) +  fi_customersaddresses_customers{bigserial)
| ¢ L { !

windexs

«indexs - ] i
i custorers sumanelvarhar] + ixfe_customersaddresses customers{bigserial)
_custo = { )

ix_customners_mobile{varchar) w P
+ ph_customersaddresses{serial)

c) Sparx Systems age 270
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Notation

The example model 1s defined using Enterprise Architect's
UML Profile for Data Modeling; the relationship between
the Tables uses the default Information Engineering
notation.

Information Engineering is one of three notations that
Enterprise Architect supports to help Data Modelers identify
cardinality 1n relationships. You can change the notation by
selecting the 'Design > Diagram > Manage > Properties'
ribbon option, clicking on the 'Connectors' page and
selecting the required option in the 'Connector Notation'
drop-down list. You would most probably change the
notation to IDEFX1, but the UML2.1 notation is also
available.

Default DBMS

Prior to creating a Physical Data Model it is advisable for
you to set the default DBMS for the project. Setting a
default DBMS ensures that all new database elements that

are created on diagrams are automatically assigned the
default DBMS.

If the default DBMS i1s not set, new Tables are created
without a DBMS assigned, this restricts Enterprise
Architect's ability to model the physical objects correctly.
For example Enterprise Architect 1s unable to determine the
correct list of datatypes for columns.

You can set the default DBMS type using:

(c) Sparx Systems 2026 Page 28 of 339
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. 'Start > Appearance > Preferences > Preferences > Source
Code Engineering > Code Editors', or

. 'Settings > Reference Data > Settings > Database
Datatypes or
. 'Develop > Data Modeling > Datatypes or

. The second data entry field in the Code Generation
Toolbar

Note: When modeling via the Database Builder the default
DBMS is defined at the model level (as a Tagged Value
'DBMS' against the <<Database>> Package) instead of at
the project level, thereby allowing for greater flexibility
when projects involve multiple DBMSs.

(c) Sparx Systems 2026 Page 29 of 339



Information Engineering 4 May, 2026

DDL Transformation

The DDL transformation converts the logical model to a
data model structured to conform to one of the supported
DBMSs. The target database type is determined by which
DBMS is set as the default database in the model (see the
Database Datatypes Help topic, 'Set As Default' option).
The data model can then be used to automatically generate
DDL statements to run in one of the system-supported
database products.

The DDL transformation uses and demonstrates support in
the intermediary language for a number of database-specific
concepts.

Concepts
Concept Effect
Table Mapped one-to-one onto Class elements.
'Many-to-many' relationships are
supported by the transformation, creating
Join tables.
Column Mapped one-to-one onto attributes.

Primary Key | Lists all the columns involved so that
they exist in the Class, and creates a
Primary Key Method for them.

(c) Sparx Systems 2026 Page 30 of 339
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Foreign Key = A special sort of connector, in which the
Source and Target sections list all of the
columns involved so that:

. The columns exist

. A matching Primary Key exists in the
destination Class, and

. The transformation creates the
appropriate Foreign Key

MDG Technology to customize default
mappings

DDL transformations that target a new, user defined DBMS
require an MDG Technology to map the PIM data types to
the new target DBMS.

To do this, create an MDG Technology .xml file named
'UserDBMS Types.xml', replacing UserDBMS with the
name of the added DBMS. Place the file in the

EA\MDGTechnologies folder. The contents of the MDG
Technology file should have this structure:

<MDG.Technology version="1.0">

<Documentation id="UserdataTypes" name="Userdata
Types" version="1.0" notes="DB Type mapping for
UserDBMS"/>

(c) Sparx Systems 2026 Page 31 of 339
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<CodeModules>
<CodeModule language="Userdata" notes="">
<CodeOptions>

<CodeOption
name="DBTypeMapping-bigint">BIGINT</CodeOption>

<CodeOption
name="DBTypeMapping-blob">BLOB</CodeOption>

<CodeOption

name="DBTypeMapping-boolean">TINYINT</CodeOptio
n>

<CodeOption
name="DBTypeMapping-text">CLOB</CodeOption>

</CodeOptions>
</CodeModule>
</CodeModules>
</MDG.Technology>

As an example, 'text' is a Common Type (as listed in the
'Database Datatypes' dialog) that maps to a new DBMS's
'CLOB' data type.

Notes

. You can define DBMS-specific aspects not depicted in a
Logical model, such as Stored Procedures, Triggers,
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Views and Check Constraints, after the transformation;

see the Physical Data Model Help topic

Example

The PIM elements

Account

+ billingAddress: String
+ closed: Boolean

+ delveryfdddress: String
+ amailbddress: Strng
+ name: Strng

aenumerations
Order Status

ttributes
- new Integer

- packed: Integer

- dispatched: Intzger
- deliverzd: Integer

=

+account

+account +hi5t:|ry

createMewAccount() : void
loadAccountDetails() : void
mankAccountClosed() : void
retrieveAccountDetails() : woid
submitMewAccountDetails() : void

+ o+

orderMumber: String

- closad: Integer Stockltem
T + catslogMumber string
+itemn
Crder
+ date: Date
+ deliverylnstructions: String
+ orderMumber: String
+ checkForQutstandingCrders() : void
Transaction \
Lineltem
+ date: Date

loadAccountHistory() : void
load OpenCrders() : void

+ quantity: Integer

™

+hashet

ShoppingBasket

After transformation, become the PSM elements

(c) Sparx Systems 2026
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Order Bl

Stockltem B

+PH_Cirder .
+FK_Order_Lineltem T
“PH stockltem|D: Integer

catalogMumbsr

aFEs

+ PE_Stockltem{integer)

+  F¥_Order_Lineltem{Integer)
{lineltemID = +PH_Stockltam
lineltem| D)

{orderl D = onderl DY

+ PHE_Order{Integer)

(stockltemID = stock|tem| D)

+FHK_Account_Crder
+FK_Lin=lt=m_Stockltzm

Account El
=]

Transaction

I
+PK_Linsltem Lineltem =]

a0DiUMmne
FK accountlD: Integer :
date: *PH linzltem|D: Integer
quantity
FK stockitemlID: Integer

+  FHE_Linsltem_Stockltem{integer)

Fia
N +  FK_Transaction_Account{ nteger) FHa
s i +  FK_Transaction_Lineltem{Intager) +  PK_Linzltem{Intager)
+  FE_Account Order{integer) =
FK_Account_ShoppingBasket{Integer) - A

N _AECoUn_ShoppingEaskeliniEgen +  PK_Transaction{Intager)

oFKs +FK_Linsltem +FH_Lineltem
+  PE_Account{Integer) +FK_Transaction_Account +FK_Transaction_Lineltem

+FK_Account_ShoppingBasket +PHK_Account

fingltemlD = finelteml DY
{accountlD = account] D) {linzltemID> = linzltzmiD}

{lineltemID = linelteml D}

ShoppingBashet D

+FK_ShoppingBasket Linsltam

{shoppingBasket|D = shoppingBasket| D)

+PH_ShoppingBaskst oFHs
+  FK_ShoppingBaszket_Lineltem{Integer)
PG

+  PK_ShoppingBasket{Integer)

Generalizations are handled by providing the child element
with a Foreign Key to the parent element, as shown.
Copy-down inheritance is not supported.
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class Class Model /

ParentClass

ChildClass

class DDL .~

ParentClass D

wcolumn =
*PK. parentClassiD: Integer

wPHe
+  PK_PamntClass(integern)

+PK_ParentClass 1

(chikdClassID = parentClassID)

wFKx

+Fk_ChildClass_ParentClass |0..1

ChildClass =

acolumne
*ofk childClassID: Intager

wP K
+  PK_ChikdClass{integer)

wFHKx
+  FK_ChildClass_ParentClass(Intager)
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Creating and Managing Data Models

Enterprise Architect is a fully featured database modeling
platform that enables the user to work with their Physical
Data models at all stages, from design right through to the
implementation of the live database, for a wide range of
database management systems such as Microsoft SQL

Server, Oracle, PostgreSQL and MySQL.

Database Engineering

[z Data bModeling Patterns

A Sarnple Data Models
Basic DBZ Model
Basic Firebird Model

Basic M5 Access Model
Basic MEAccess 2007 Model

Basic MywS0L Model
Basic Oracle Model

Basic Postgre30L Model
Basic 0L Server MModel

Basic 50Lite Model
A ErnpbyfStarter Data Models
CB2 hodel Structure

Firebird Model Structure
kA% Access Model Structure

M5 Access 2007 Model Structure

by S0l Model Structure
Oracle Model Structure
Postgre=0L Model Structure
S0L Server Model Structure
S0Lite Model Structure
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This figure shows the starter model wizard patterns for
database design for a range of RDBMS.
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Create a Data Model from a Model
Pattern

The easiest way to create a Data Modeling workspace 1s to
use the predefined Database Model Patterns, available
through the Model Builder. Enterprise Architect provides a
Pattern for each DBMS supported by the system.

Access

Display the Model Builder using any of the methods
outlined here.

In the Model Builder dialog, select the 'Database
Engineering' Perspective.

Ribbon Start > Personal > Model Builder
Design > Package > Model Builder

Context Right-click on Package | Model Builder
Menu (pattern library)

Keyboard Ctrl+Shift+M
Shortcuts

Other Browser window caption bar menu |
Model Builder (pattern library)
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Create a Data Model

Field/Button Action

Add to Displays the name of the selected root
Package Package.

Technology | Click on 'Database’.

Name If necessary, expand the Database
Engineering group of Patterns.

Click on the checkbox against each
Database Management System you are
supporting in the model.

All Click on this button to select the
checkboxes for all Database Engineering
model types and the Entity Relationship
diagram, to include them all in the model.

None Click on this button to clear all selected
checkboxes so that you can re-select
certain checkboxes individually.

OK Click on this button to add to the Browser
window the Packages and diagram for
cach Database Management System you
are modeling.
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What each Data Modeling Pattern provides

. A summary diagram of the model

. A Report Specification Artifact element (on the summary
diagram) that can be used to quickly document the data
model

. A Package for each of the Logical and Physical models

. Within the Physical Model Package, a predefined
hierarchy of sub-Packages, one for each object type
supported by the DBMS being modeled (such as Tables,
Views, Procedures and Functions); these automatically
organize the database objects as they are added

. The DBMS type for the workspace
. A default owner

. A Data Modeling diagram in each Package with the
connector notation set to IDEF1X

Notes

. Once a data modeling workspace has been created, you
can begin to develop your model in one of two ways:
- Through the Database Builder, which 1s a
purpose-built view that supports database modelers
- Through the Browser window and diagrams, which
is the traditional method that might suit users
who are experienced UML modelers
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Create a Data Model Diagram

To model the structure of a relational database you use Data
Modeling diagrams, which are extended Class diagrams.
When you open a Data Modeling diagram the matching
Diagram Toolbox 1s automatically opened, which contains
the diagram elements:

. Table

. View

. Procedure

. Sequence

. Function

. Association and

. Database Connection

Access

Display the 'New Diagram' dialog using any of the methods
outlined here.

Ribbon Design > Diagram > Add Diagram

Context Right-click on Package | New Diagram

Menu Right-click on element | Add | New
Diagram

Keyboard Ctrl+Insert
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Shortcuts

Other Browser window caption bar menu | New
Diagram

Create a Data Modeling diagram

Field/Button @ Action

Package Defaults to the name of the Package
selected in the Browser window or, if the
parent is an element, the name of the
Package containing that element.

If you are adding a diagram directly to a
Package and notice that it is not the
correct Package, click on the (&) button
and browse for the correct Package.

Parent If you are adding a diagram to an
element, this field displays the element
name.

Diagram This field defaults to the name of the

parent Package or element.

If required, overtype the default name
with your preferred name.
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Select From | Click on this header and select the
Perspective Group and Perspective or
Workspace most appropriate to the area
you are working in (in this instance,

'Information Engineering > Database
Models').

From the options listed in the panel, click
on 'Extended'.

Diagram Click on 'Data Modeling'.
Types
OK Click on this button to create the diagram.

The Diagram View displays the blank
diagram, and the 'Data Modeling' pages
display in the Diagram Toolbox.

Drag elements and connectors from the
Toolbox onto your diagram, to create
your data model.

Notes

. The default diagram connector notation for all new
diagrams 1s Information Engineering, although many data
modelers prefer the notation IDEF1X; to make this
change select 'Design > Diagram > Manage > Properties >
Connectors' and click on the required option in the
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'Connector Notation' drop-down list
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This example of a Data Model diagram shows a data model
of a bookstore warehousing system. The tables are modeled
using a stereotyped class with a compartment for Columns
which displays the name and type of the Columns. Primary
and Foreign Keys are indicated by stereotypes on the
columns. You can examine this model in greater detail in
the Example model, installed with Enterprise Architect and

available from this ribbon location.
Start > Help > Help > Open the Example Model

customers =] =]
wcolumn»
“PK_id: bigserial
first_name: varchar{50)
middle_name: varchar(50)
sssssss :varchar(50)
date_of_birth: date
phone_no: varchar(20)
mobile_no: varchar(.
email: varchar{100)
nnnnnnnnnnnnn
+pk_custome +pk_customers
s: tex
T
+pk_supplie
+k_customersaddresses_customers
L +fk_customersorders_custom +fk_products_suppliers
customers_addresses 2 tomers_order. 2 products B
«column»
*PK id: serial
FK customer_id: bigserial
billing_or_delivery: bit(1) = 1
fk_customersor dersstatuses . customersor ders
omers_orders statuses =]

*pfK customerorder_id: bigint
*pfK product_id: bigint

discount_percentage: double precision

comments: : text

Data modeling diagram with suppressed operation
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compartment showing tables connected to indicate foreign
key relationships.
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The Database Builder
E

Database
Builder

The Database Builder is a tailored interface for the data
modeler; all database-related modeling tasks can be
performed 1n a single location. The interface and its related
screens include only the information relevant to data
modeling, thereby streamlining and simplifying the
modeling process.

Access

Ribbon Develop > Data Modeling > Database
Builder

Database Builder
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» Database Builder v
@StaltPage iz Getting Started T Database Builder %El:ldtd Model - PostgreSQL Eilja(abase Builder X 4 b
4 g orders (postgres) Columns | Constraints/Indexes SOL Scratch Pad  Database Compare  Execute DDL
4 DR Tables
public.customers Name Type Length Scale PK  NotMull  Alias Initial Value
E Et::z::zz eses customerorder_id bigint ¥
F public.c bigint -
Qrk_c mersorder louble pre
] Ak Icts louble pre
4 IiL”J“C-C jouble precision
€, fk_customersordersstatuses_customersorders
[ public.products fouble pre
publicsuppliers comments text
Column (product_id) B iU &' = éE x xz% ._:I
AutoMNum False i
StartNum
ncrement
1enceName

This figure shows the Database Builder loaded with the
'Orders (postgres)' data model as 1t appears in the Example
model.

Overview

The interface of the Database Builder consists of:

. A Tree of data models, listing all defined data models in
the current repository

. A 'Columns' tab through which you directly manage the
Table columns

. A 'Constraints/Indexes' tab for the direct management of
Table constraints such as Primary Keys, Foreign Keys and
Indexes

. An SQL Scratch Pad that you can use to run ad-hoc SQL
queries against a live database

. A 'Database Compare' tab that displays the results of
comparisons between the data model and a live database

. An 'Execute DDL' tab on which you can execute
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generated DDL against a live database, instantly

You can use the Database Builder to:

Create, edit and delete database objects (Tables, Views,
Procedures, Sequences and Functions)

Create, edit and delete Table constraints (Primary Keys,
Indexes, Unique Constraints, Check Constraints and
Triggers)

Create, edit and delete Table Foreign Keys

Reverse engineer database schema information

Generate DDL from a modeled database

Compare a live database schema with a modeled database
Execute generated DDL against a live database

Execute adhoc SQL statements against a live database

Notes

The Database Builder is available in the Corporate,
Unified and Ultimate Editions of Enterprise Architect
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Opening the Database Builder

When you first open the Database Builder, it searches the
entire project for all Packages that have the stereotype
<<Data Model>> and loads the corresponding data models
as root nodes into the tree. A grayed-out icon indicates that
the details of the data model are not loaded.

= Database Builder

@Startl-"age aDatabasEBuilder x
u Orders (postgres) Columns

Mame

This figure shows the Database Builder with a single
unloaded data model called 'Orders (postgres)'.

Using the Database Builder

You can start working in the Database Builder in one of
these two ways:

Task Action

Create anew @ Once you have opened the Database

data model Builder view, right-click in the empty
space of the tree and select 'New Data
Model' to invoke the Model Builder.

Load an Once the Database Builder view is
existing Data = opened, load any of the defined data
Model models by either:
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. Right-clicking on the name and
selecting 'Load', or

. Double-clicking on the name

Data Model Properties

In earlier versions of Enterprise Architect (prior to the
introduction of the Database Builder) it was necessary for
the data modeler to manually set properties on database
objects before some tasks were allowed. For example,
Enterprise Architect would not allow the definition of a
Table column without the Table first being assigned a
DBMS. This was because the DBMS controls the list of
available datatypes.

To improve efficiency and the user experience, the Database
Builder defines defaults for a number of properties at the
data model level and then applies these default values
automatically whenever new objects are created.

Properties
Option Description
DBMS Defined against: The data model's

<<Database>> Package
Defined as: Tagged Value
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Details: Defines the DBMS of the
current data model

Extra Information:

. Controls which logical folders are
shown for the current data model in the
Database Builder's tree

. Controls what DBMS rules are applied
during database comparisons

. Is automatically assigned to every new
database object created in the current
data model

DefaultOwne = Defined against: The data model's
r <<Database>> Package

Defined as: Tagged Value

Details: Defines the default Owner for
the current data model

Extra Information:

. Is automatically assigned to every new
database object created in the current
data model, if the DBMS supports
owners/schemas

DefaultConn = Defined against: The data model's
ection <<Database>> Package

Defined as: Tagged Value

Details: (Optional) the name of the
default connection
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Extra Information:

. Whenever a data model is loaded, the
'DefaultConnection’ property 1s
checked; if present, the Connection by
that name is automatically made active

. The database engineering model
Patterns do not define a value for this
property, it is created or updated

whenever a user sets a Connection as
the default

Notes

. If a data model is selected in the Browser window when
the Database Builder is opened, that model's details will
be automatically loaded
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Working in the Database Builder

When a data model 1s loaded, the Database Builder creates a
set of logical folders, one for each object type supported by
the current DBMS. Each logical folder 1s populated with all
objects of that type found in the data model's hierarchy of
Packages (as shown in the Browser window).

g Database Builder
@ﬁart Page EﬂDatabasE Builder =
| E]Ordersipu:ustgres] Columns
4 D3 Tables
public.customers Marme

[+ public.customers_addresses
[+ public.customers_orders
[= public.customers_orders_items
[ public.customers_orders_statuses
[+ public.products
public.suppliers
4 Cxviews
E public.wvwCustomerAddresses
E public vwCustomerOrders_AllDetails
E public vwCustomerOrderStatuses
4 LA Functions
E public.send_customer_notification
Lg]Sequences
A Ly Queries
£ Show Table List
4 L Connections
#Drders[dev]
-i:ﬁ' orders (prod)
#Drdersiuat]

Colu

In this image the data model 'Orders (postgres)' shows
logical folders for Tables, Views, Functions, Sequences,
Queries and Connections. It 1s worth noting there 1s no
folder for 'Procedures' since PostgreSQL does not support
database procedures.

Available Actions in the Database Builder
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Tree

The majority of the Database Builder functions are
accessible via context menus. Each object in the Tree has its
own set of unique menu items based on its type and status.
This table describes the available context menu items and
identifies which objects they apply to.

Menu Option Applies to / Description

New data Applies To: Blank Space
model Description: Opens the Model Builder.

Refresh All Applies to: Blank Space

Description: Reloads the complete list of
data models.

Load Applies to: Root Node
Description: Loads the full details of the
data model.

Unload Applies to: Root Node

Description: Unloads the full details of
the data model.

Import DB Applies to: Loaded Root Node

Schema Description: Opens the 'Import DB
schema' dialog using the current active
connection as the Live database source.
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Generate Applies to: Loaded Root Node, Folder,
DDL Table, View, Procedure, Function,
Sequence, Package
Description: Opens the 'Generate DDL'
dialog with the current object(s) selected.

Show Applies to: Loaded Root Node, Folder,
Differences Table, View, Procedure, Function,
Sequence

Description: Compares the selected
objects to the current active connection.

Show Applies to: Loaded Root Node, Folder,
Differences Table, View, Procedure, Function,
with Options = Sequence, Package

Description: Compares the selected
objects to the current active connection
and optionally ignore some of the
differences based on the specified
compare options.

Manage Applies to: Loaded Root Node
DBMS Description: Opens the 'Manage DBMS
Options Options' dialog, which can be used to

change the allocated DBMS and Owner
of multiple objects.

View Record @ Applies to: Table, View
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Count Description: Builds and runs a SELECT
query (formatted to suit the element's
DBMYS) to show the number of records in
the selected Table or View.

If there is no active connection, you are
prompted to select one.

View Top Applies to: Table, View

100 Rows Description: Builds and runs a SELECT
query (formatted to suit the element's
DBMYS) to show the top 100 rows of the
selected Table or View.

If there 1s no active connection, you are
prompted to select one.

View Top Applies to: Table, View

1000 Rows Description: Builds and runs a SELECT
query (formatted to suit the element's
DBMS) to show the top 1000 rows of the
selected Table or View.

If there is no active connection, you are
prompted to select one.

View All Applies to: Table, View

Rows Description: Builds and runs a SELECT
query (formatted to suit the element's
DBMYS) to show all rows of the selected
Table or View.
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If there is no active connection, you are
prompted to select one.

Properties Applies to: Loaded Root Node, Folder,
Table, View, Procedure, Function,
Sequence, Package, Connection

Description: Opens the standard
'Properties' dialog for the selected object.

Find in Applies to: Loaded Root Node, Folder,

Project Table, View, Procedure, Function,

Browser Sequence, Package, SQL Query,
Connection

Description: Finds the selected object in
the Browser window.

Refresh Applies to: Loaded Root Node

Description: Reloads the details of the
current loaded data model. This 1s
necessary when objects are added,
changed or deleted by other users or
when the changes are performed outside

of the Database Builder.
Add new Applies to: Folder, Table, View,
<type> Procedure, Function, Sequence, Package,

SQL Query, Connection
Description: Creates a new object of the
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specified type.
Clone Applies to: Folder, Table, View,
<name> Procedure, Function, Sequence, Package,

SQL Query, Connection

Description: Makes a new copy of the
selected object. When you select this
option, a prompt displays on which you
set the name and owner of the new
object. For Table objects, you can choose
which existing constraints should be
copied (and set a name for each one)
along with which Foreign Keys should be
copied. For SQL-based objects, you can
make any necessary changes to the SQL
for the new element.

Delete Applies To: Table, View, Procedure,
<name> Function, Sequence, Package, SQL
Query, Connection

Description: Permanently deletes the
selected object from the repository.

Add new Applies to: Table
Foreign Key Description: Creates a new relationship
on <name> between the selected Table and another

one, then shows the 'Foreign Key
Constraint' screen for the new
relationship.

c) Sparx Systems age 590
(c)S S 2026 P 59 of 339



Information Engineering 4 May, 2026

SQL Object = Applies to: View, Procedure, Function,
Properties Sequence

Description: Opens the 'SQL Object
Editor' screen.

Edit Applies to: SQL Query
Description: Loads the SQL (as defined

in the selected element) into the SQL
Scratch Pad.

Run Applies to: SQL Query
Description: Loads the SQL in the SQL
Scratch Pad and runs it.

If there 1s no active connection, you are
prompted to select one.

Set as active | Applies to: Connection

b Description: Flags the selected Database
Connection Connection as the active one for the
current session.

Set as Applies to: Connection
Default DB ' Description: Flags the selected Database
Connection Connection as the active one each time

the data model 1s loaded.

DB Applies to: Connection
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Connection Description: Opens the 'Database
Properties Connection Properties' screen, to manage
the connection settings.

Create/Edit/Delete Database Objects

The pages listed in this section describe in detail how to use
the Database Builder's interface to create and manipulate
database Tables; however, the process of creating and
manipulating SQL-based database objects 1s documented 1n
other areas. See these topics for details:

. Database Views

Database Procedures

Database Functions

Database Sequences

Database Connections

Database Connections in the Database
Builder

When performing certain tasks such as 'Compare' or
'Execute DDL', the Database Builder requires an active
database connection. Only one database connection can be
made active (indicated by a colored 'Database Connection'
icon, while the others are gray) at a given time. If a database
connection 1s not currently active and you try to perform a
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task that requires one, the Database Builder performs one of
these actions based on how many connections are defined:

. 0 Connections — prompts you to create a connection and,
if successful, continues

. 1 Connection — sets it as active and continues

. 2 (or more) Connections — prompts you to select one and,
1f successful, continues
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Columns

Tables are the fundamental database object, and Columns
(and their properties) are the most frequently modified Table
feature updated and changed by data modelers, therefore the
'Columns' page is conveniently located as the first page of
the Database Builder's interface.

Once a Table is selected in the Database Builder's tree, the
'Columns' page is populated with the currently defined list
of columns for that Table. The data modeler can then make
changes to main column properties directly in the list or
grid. As the data modeler selects individual columns in the
list, the column's extended properties (and Comments) are
shown immediately under the list, allowing modification to
these extended properties.

» Da A v X

@Startpage @Dazahase Builder X o
4 | Orders (postgres) Columns | Constraints/Indexes SQL Scratch Pad Database Compare Execute DDL
4 B3 Tables
E public.customers Name Type length  Scale PK Mot Nul  Alias Initial Value

This figure show the Database Builder interface showing the
tree of objects and the Columns tab showing the Columns
for the selected table.
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Notes

. The 'Columns' page will only be populated when a Table
item 1s selected in the Database Builder's tree

(c) Sparx Systems 2026 Page 64 of 339



Information Engineering 4 May, 2026

Create Database Table Columns

A database Table column is represented in the UML Data
Modeling Profile as an attribute with the <<column>>
stereotype. For a selected Table, you can review the existing
columns and create new columns, on the 'Columns' page of
the Database Builder or on the 'Columns and Constraints'
screen.

You can define column details directly on the list of
columns on the 'Columns' tab. The changes are
automatically saved as you complete each field. Some fields
have certain restrictions on the data you can enter, as
described here. The tab also contains a 'Properties' panel and
a 'Notes' field, which are populated with the existing
information on the selected column. Each new column that
you create 1s automatically assigned a set of default values
and added to the bottom of the list.

Access
Ribbon Develop > Data Modeling > Database
Builder > Click on Table > Columns >
Right-Click > Add new Column
Context In diagram, right-click on required Table |
Menu Features | Columns | Right-Click | Add

new Column
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Keyboard Select a table | F9 | Tab Key (to set input
Shortcuts focus on the 'Columns' tab) | Ctrl+N

Create columns in a Table

Option Action

Name Overtype the default name with the
appropriate column name text.

Type Click on the drop-down arrow and select
the appropriate datatype for the column.

The available datatypes depend on the
DBMS assigned to the parent Table.

Length (Optional) Some datatypes have a length
component - for example, VARCHAR
has a length that defines the number of
characters that can be stored. If the
datatype does not have a length
component, this field is disabled.

If the field 1s available and if you need to
define a number of characters, type the
value here.

Scale (Optional) Some datatypes have a scale
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component - for example, DECIMAL has
a scale that defines the number of
decimal places that can be held. If the
datatype does not have a scale
component, this field is disabled.

If the field 1s available and if you need to
define a scale, type the value here.

PK Select the checkbox if the column 1s part
of the Primary Key for this Table.

Not Null Select the checkbox if empty values are
forbidden for this column.

The checkbox is disabled if the 'PK'
checkbox 1s selected.

Alias If required for display and documentation

purposes, type in an alternative name for
the field.

Initial Value | Ifrequired, type in a value that can be
used as a default value for this column.

Notes Type in any additional information
necessary to document the column.

You can format the text using the Notes
toolbar at the top of the field.
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Column Properties

The appropriate properties for the Table's Database
Management System automatically display in the 'Property’
panel (expand the 'Column (<name>)' branch if they are not
visible).

Property DBMS
Autonum Oracle
(Startnum MySQL
Increment) SQL Server
DB2
PostgreSQL

Notes: If you require an automatic
numbering sequence, set this property to
True and, if necessary, define the start
number and increment.

Generated DB2

Notes: Set this additional property for
auto numbering in DB2, to 'By Default' or
'Always'.

NotForRep SQLServer

Notes: Set this property to True if you
want to block replication.
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Zerofill MySQL

Notes: Set this property to True or False
to indicate if fields are zerofilled or not.

Unsigned MySQL
Notes: Set this property to True or False

to indicate whether or not fields accept
unsigned numbers.

LengthType @ Oracle

Notes: Set this property to define the
character semantics as 'None', 'Byte' or
'Char’.
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Delete Database Table Columns

For a selected database Table, you can review the existing
columns and delete any individual column, on the 'Columns'
tab of the Columns and Constraints screen.

Access

Use one of the methods outlined here to display a list of
columns for a table, then select a column and delete it.

When you select the 'Delete column '<name>" option, if all
validation rules are satisfied the column is immediately

deleted.

Ribbon Develop > Data Modeling > Database
Builder > Click on Table > Columns >
Right-click on column name > Delete
column <name>

Context In diagram, right-click on required Table |
Menu Features | Columns | Right-click on
column name | Delete column <name>

Keyboard F9 | Use 'Up Arrow' or 'Down Arrow' to
Shortcuts select a column | Ctrl+D

Notes
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. If the deleted database Table column 1s involved in any
constraints it will automatically be removed from them
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Reorder Database Table Columns

If you have several columns defined in a database Table,
you can change the order in which they are listed. The order
in the list 1s the order in which the columns appear in the
generated DDL.

Access

Use one of the methods outlined here to display a list of
columns for a Table, then select a column and reposition it
within the list.

Ribbon Develop > Data Modeling > Database
Builder > Click on Table

Context In diagram, right-click on required Table |

Menu Features | Columns

Keyboard F9
Shortcuts

Change the column order

Ste Action
p
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1 | Inthe 'Columns' tab, click on the required column
name in the list.

2 Right-click and select the:

. 'Move column <name> up' option (or press
Ctrl+Up Arrow) to move the column up one
position

. 'Move column <name> down' option (or press
Ctrl+Down Arrow) to move the column down one
position

These options have an immediate effect both in the

'Columns' tab and on a diagram.
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Constraints/Indexes

Tables are the fundamental database object, and Constraints
and Indexes (and their properties) are the second most
frequently modified Table feature updated and changed by
data modelers, therefore the 'Constraints/indexes' page 1s
conveniently located as the second page of the Database
Builder's interface.

Once a Table is selected in the Database Builder's tree, the
'Constraints/Indexes' page is populated with the currently
defined list of constraints and indexes for the selected Table.
The data modeler can then make changes to main properties
directly in the list. As the data modeler selects individual
constraints or indexes 1n the list, the constraint's extended
properties (and Comments) are shown immediately under
the list, allowing modification of these extended properties.

» r A v ox

@ start Page | EdDatabase Builder X 4 b
4 | orders (postgres) Columns | Constraints/Indexes | SOL Scratch Pad  Database Compare  Execute DDL
4 B Tables
public.customers Name Type Alias Columns
[ [E public ck_customersardersitems_discount check
3 public FK customerorder id
F public s_items Fic product_id

PK customerorder_id, product_id

Constraint Involved Columns | Notes

Assigned Columns Available Columns

This figure show the Database Builder interface showing the
tree of objects and the Columns tab showing the Columns
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for the selected table.

Notes

. The 'Constraints/Indexes' page will only be populated
when a Table item in the Database Builder's tree 1s
selected
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Database Table Constraints/Indexes

Within Enterprise Architect, Table Constraints and Indexes
are modeled on the same screen; collectivity they are
referred to as Constraints. Database Constraints define the
conditions imposed on the behavior of a database Table.
They include:

. Primary Key - uniquely identifies a record in a Table,
consisting of one or more columns

. Index - improves the performance of retrieval and sort
operations on Table data

. Unique Constraints - a combination of values that
uniquely identify a row in the Table

. Foreign Key - a column (or collection of columns) that
enforce a relationship between two Tables

. Check Constraints - enforces domain integrity by limiting
the values that are accepted by a column

. Table Trigger - SQL or code automatically executed as a
result of data in a Table being modified

In Enterprise Architect, you can define and maintain Table
Constraints using either the purpose-designed
'Constraints/Indexes' page of the Database Builder or the
Columns and Constraints screen.

Access

c) Sparx Systems age 760
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Ribbon Develop > Data Modeling > Database
Builder > Click on Table name >
Constraints/Indexes | Right-click | Add
New Constraint

Context In diagram | Right-click on Table |
Menu Features | Constraints/Indexes |
Right-click | Add New Constraint

Keyboard Click on Table: F9 > Constraints/Indexes:
Shortcuts Ctrl+N

Create a Constraint

The process of creating any of these constraint types is the
same and is achieved in one of the ways described here.

Create a Constraint - Using the context menu
or keyboard

Ste Action
p

1 A new constraint is automatically created and
assigned the default name constraint n (where n is a
counter) and a '"Type' of 'index’.
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Overtype the default name with your own constraint
name.

If necessary, in the "Type' field click on the
drop-down arrow and select the appropriate
constraint type.

If you prefer, type an alias for the constraint, in the
'Alias' field.

The 'Columns' field 1s read-only; it is populated with
the columns that you assign to the 'Involved
Columns' tab.

Create a Constraint - Overtype the template

text

Ste Action

P

1

On the 'Constraints/Indexes' tab for the selected
Table, the list of constraints ends with the template
text New Constraint.

Overtype this text with the appropriate constraint
name, and press the Enter key.

The new constraint 1s automatically created and
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assigned the default Type of index.

If necessary, in the "Type' field click on the
drop-down arrow and select the appropriate
constraint type.

If you prefer, type an alias for the constraint, in the
'Alias' field.

The 'Columns' field 1s read-only; it is populated with
the columns that you assign to the 'Involved
Columns' tab.

Assign Columns to a Constraint

The constraint types of Primary Key, Foreign Key, Index
and Unique all must have at least one column assigned to
them; this defines the columns that are involved in the
constraint.

Ste Action

P

1

On the 'Constraints/Indexes' tab for the selected
Table, click on the constraint to which you are
assigning columns.

The 'Available Columns' panel lists all columns
defined for the Table.

For each column to assign to the constraint,
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right-click on the column name and select 'Assign
column <name>"'.

The column name is transferred to the 'Assigned
Columns' list.

Unassign Columns from a Constraint

Ste Action
p

1 | On the 'Constraints/Indexes' tab for the selected
Table, click on the constraint from which you are
unassigning columns.

2 In the 'Assigned Columns' list, right-click on the
name of the column to unassign from the constraint
and select 'Unassign column <name>'.

The column name is transferred to the 'Available
Columns' list.

Reorder the Assighed Columns in a
Constraint

If you have a number of columns 1n the constraint, you can
re-arrange the sequence by moving a selected column name
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one place up or down the list at a time. To do this:

. Right-click on the column name to move and select either:
- Move column '<name>' up (Ctrl+Up Arrow) or
- Move column '<name>' down (Ctrl+Down Arrow)

Delete a constraint

To delete a constraint you no longer require, right-click on
the constraint name 1n the list on the 'Constraints/Indexes'
tab and select the 'Delete constraint <name>' option. If all
validation rules for the given constraint type are met, the
constraint 1s immediately removed from the repository along
with all related relationships (if there are any).
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Primary Keys

A Primary Key is a column (or set of columns) that uniquely
identifies each record in a Table. A Table can have only one
Primary Key. Some DBMSs support additional properties of
Primary Keys, such as Clustered or Fill Factor.

Access
Ribbon Develop > Data Modeling > Database
Builder > Click on Table name
Context In diagram | Right-click on Table |
Menu Features | Constraints/Indexes

Create a Primary Key

In Enterprise Architect you can create a Primary Key from
either the 'Columns' tab or the 'Constraints/Indexes' tab. In
either case, when you add a column to a Primary Key
constraint, the column is automatically set to be 'Not Null'".
Additionally any diagram (assuming the 'Show Qualifiers
and Visibility Indicators' option is set) containing the Table
element will show the 'PK' prefix against the column name.
In this image, see the first column 'id: bigserial'.
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customers E

*PK id: bigserial
first_name: varchar(50)
middle_name: varchar(50)
surname: varchar{50)
date_of _birth: date
phone_no: varchar(20)
mobile_no: varchar(20)
email: varchar(100)
comments: text

«PKx»

+ pk_customers(id: bigserial)
«unigues»

+ uq_customers_email(email: varchar)
aindex»

+ ix_customers_surname(surname: varchar)
+ ix_customers_mobile(mobile_no: varchar)

Create a Primary Key - from the Columns tab

Ste Action
P

1 Either:

. In the Database Builder, click on a Table with one
or more defined columns, and click on the
'Columns' tab, or

. On a diagram, click on a Table and press F9 to
display the 'Columns' tab

2 | For each column to include in the Primary Key,
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select the 'PK' checkbox.

If a Primary Key constraint is not previously defined
for the current Table, the system will create a new
constraint using the Primary Key Name template.

Create a Primary Key - from the Constraints
tab

Ste Action
p
1 Either:

. In the Database Builder, click on a Table with one
or more defined columns, and click on the
'Constraints/Indexes' tab, or

. On a diagram, click on a 